



Digital Security: Vulnerabilities Of Macs & iDevices 

AND OUR PICNIC IS JUNE 10TH!          SEE PAGE 49.  

FOUNDED MAY 1989 

MEETINGS - SECOND  

  SATURDAY OF THE MONTH

MAY LOCATION 
REMEMBER - We continue to meet at Hershey’s Mill in West Chester. Take Greenhill to 
Hershey’s Drive entry and go up hill to Community Center. Map is at tinyurl.com/mrmtnd7. 

EDITOR COMMENTS 

I read a recent investment letter 
stating that the number 1 actions 
to take in securing your privacy 
is to start using a password 
manager and using unique 10-
character-plus passwords for 
every sign-in you have. I would 
modify that to 16-characters for 
t h e i m p o r t a n t o n e s , b u t 
otherwise great advice.


“The best approach to a long 
password is to s t r ing a 
few  random words with one 
and another that give you a 
visual you can remember and 
use for recall when you need 
it.” Remember This! tinyurl.com/
kftet4g.

Jonathan Takiff ’s art icle in 
philly.com relates to installing an 
Eero mesh network in an old 
East Mount Airy house. Very 
informative. tinyurl.com/lslfo4e.

A free security utility called 
Oversight alerts you if someone 
attempts to access your Mac’s 
web camera or microphone. 
tinyurl.com/llddmhk.

AT TIMES IMAGES MAY BE A BIT 
FUZZY. THAT’S NORMALLY 
BECAUSE ORIGINAL IMAGES 
WERE FUZZY. IF YOU NEED TO 
READ THEM, PLEASE GO TO THE 
ORIGINAL ARTICLE.

Attacks on computers are becoming increasingly 
sophisticated. Mike will review general principles of digital 
security, vulnerabilities of Macintosh computers and iOS 
devices (iPhones and iPads), and suggest simple steps users 
can take to protect themselves against attack. These 
strategies are based on reports of current and emerging 
threats, his familiarity with the security features of Apple 
products, and his practical experience helping users, both 
experienced and naive. His presentation will be aimed at 
people using personal Macintosh computers or iDevices at 
home or on the road.

Mike Inskeep has been supporting Macintosh computers and other Apple 
products for 26 years: as a Microcomputer Support and then Director of 
Microcomputing for the University of Pennsylvania’s School of Arts and Sciences; 
as Technology Coordinator/Teacher for Friends School Haverford; and since 1999 
through his independent consulting business, Gentle Computer Helpers. website 
here.


http://tinyurl.com/kftet4g
http://tinyurl.com/kftet4g
http://tinyurl.com/lslfo4e
http://tinyurl.com/llddmhk
http://tinyurl.com/mrmtnd7
https://gentlehelpers.com/
https://gentlehelpers.com/
http://tinyurl.com/mrmtnd7
http://tinyurl.com/kftet4g
http://tinyurl.com/kftet4g
http://tinyurl.com/lslfo4e
http://tinyurl.com/llddmhk
https://gentlehelpers.com/
https://gentlehelpers.com/
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MLMUG Email list

The Main Line Macintosh Users 
Group has its own email list. 
Compose your letter and email it to 
mlmug@yahoogroups.com and 
your message will be sent to 
everyone on the mailing list. 
Posting to this list is restricted to 
MLMUG members. Contact Bob 
Barton if you are a member and 
you are not on the list.

Please observe rules of etiquette. 
See the Yahoo Groups Terms of 
Service. The MLMUG list may be 
used to post Apple/Macintosh-
related items for sale, but any 
solicitation of members through 
the list is forbidden without the 
written consent of a MLMUG 
officer. The list is hosted at Yahoo 
Groups.

New Users SIG

You don’t have to wait a whole month to 
get answers to your basic Mac questions! 
Get together with other members on the 
fourth Saturday (i.e., two weeks after each 
regular meeting) for the Startup Folder Lite.


Many new users have said that they can 
learn much more from face-to-face 
meetings than they do from manuals or 
other sources. That’s what this meeting is 
all about. Go to www.mlmug.org/nusfl.html 
for details.


Macintosh Programming SIG/ 
Philly Mac Programming Group 

The objective of this group is to help 
members become more familiar with the 
c o n c e p t s o f M a c i n t o s h a n d i O S 
programming, i.e., the elements of the 
Macintosh GUI, user interaction, file 
sys tem, e tc . , and the ma in Mac 
programming tools: AppleScript, Java, C, 
and Objective C.


The Philly Mac Programming SIG meets at 
10:30 AM on the first Saturday of each 
month, but usually skips January and July. 
Contact Deivy Petrescu, Chair, for venue 
information. www.phillymacprog.org. The 
next meeting will probably be at Ludington 
Library in Bryn Mawr.


Typical Meeting Agenda

9:00 - 9:05: 	 Call to order in main meeting 

room.


9:05 - 10:05: Three Concurrent Special 
Interest Groups (SIGs) convene in 
separate rooms. The three current 
SIGs are:


	 Newer Users- We cover the most 
basic questions you may have about 
your Mac/iDevices and how to use 
them.


	 Multimedia - We discuss using your 
Mac/iDevices and applications for 
photo, video, audio, and print media.


	 OS - We go beyond basics to discuss 
Apple’s current operating systems, 
using your Macs & iDevices, & various 
applications, & have Q&A.


10:05 - 10:15: Continuation of Q&A for all 
attendees.


10:15 - 10:30: Welcome and other business.


10:30 - 11:50: Main Presentation (by a 
member or guest)


11:50 - Noon: Raffles and silent auctions.


Come join some fellow MLMUG members 
for lunch after the meeting at a nearby 
restaurant. 

http://www.mlmug.org/nusfl.html
http://www.phillymacprog.org
mailto:mlmug@yahoogroups.com
http://www.mlmug.org/nusfl.html
http://www.phillymacprog.org
mailto:mlmug@yahoogroups.com
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Membership Information 
Membership dues are $25 for individuals and $35 
for families. Memberships are based on your 
anniversary date, which is the month you joined. 
You will be e-mailed reminders when membership 
fee is due.  
If you’re just visiting to check us out, or if you’ve 
been visiting for some time, but haven’t joined, 
consider these BENEFITS OF MEMBERSHIP:

• Monthly meetings, where you can learn, share, 

and meet everyone f rom work ing Mac 
professionals to new Mac users from all 
backgrounds.


• Monthly newsletter, which is full of interesting 
Mac news, tips, and information.


• Useful free items at the monthly Raffles. 

• Discounts. Vendors offer special prices to User 

Group members.

• Web Site with 12 months of MLMUG 

newsletters, meeting information, a member 
directory, directions to our meetings, and much 
more! Our web site is www.mlmug.org.


• MLMUG Mailing List, to post technical 
questions or comments to each other and the 
experts within the group. 


• Reviewers keep items reviewed.

Are you ready to join? Please make a check 
payable to MLMUG and bring it to a monthly 
meeting or mail it to:


Treasurer, MLMUG

P.O. Box 1374


Southeastern, PA 19399


Newsletter Copy Editor & Apple 
User Group Ambassador 

Deane Lappin

deanezl@verizon.net 

Newer Users SIG Co-Chair & 
Deputy Webmaster 

Bob Barton

barton@bee.net


Newsletter Graphics Editor 
Sally Bazrod


sallybazrod@mac.com

OS/iOS SIG Chair 

Adam Rice

adam@adamrice.org


Raffle Chair 
Susan Czarnecki 

sparsefur@yahoo.com 
Social Secretary 
Gail Montgomery


gailemontgomery@comcast.net

Webmaster 

Deivy Petrescu

mlmug_2004@dicas.com


President, Program Director & 
Vendor Liaison 

Maria O. Arguello

mariarguello@mac.com


Vice President & Multimedia SIG 
Co-Chair 

Larry Campbell

lcampbell9@me.com


Treasurer, Membership & 
Facilities Coordinator 

Elliott Cobin

eicobin@yahoo.com


Secretary & Newsletter Editor 
Mark Bazrod


msb@lpilease.com

Member-at-Large 

Deane Lappin

deanezl@verizon.net

Educational Liaison 

Linda McNeil

mcneil.linda@gmail.com

Multimedia SIG Co-Chair 

Nicholas Iacona

nick@nickiacona.com 
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By Mark Bazrod 



Bookmarks 

Buying a “New” Mac 

Buying a new Mac is somewhat similar to voting in a national 
election. You may do it roughly every four years, but you have to 
pay attention between the quadrennial activities to do the job well. 
It’s a rough analogy, but it indicates you have to do more than just 
periodically focus on voting or buying. 


Understand Apple’s Release Cycles  

Apple releases products and services on a somewhat regular 
basis, although there are always some exceptions and cycles 
somewhat change over time.


Apple releases a major revision of the operating system in the fall 
of every year. It releases a new iPhone in the fall of every year. It 
releases a new iPad in the spring of every year. However, its 
releases of new iMacs, MacBooks, and MacBook Pros has been 
erratic and its release of a new Mac Pro has been, shamefully 
delayed. 


Nonetheless, having a rough idea of when new products may be 
announced is helpful in timing your buy. In addition, the Mac 
information sites on the Internet have ideas or rumors as to what 
may be coming and when. 


Decide when you want to start the buying process 

Most of us don’t have to buy an Apple product because the old 
one died. We need or want additional functionality. So make a 
conscious decision to purchase a replacement and give yourself 
perhaps a six-month window before you actually make the 

purchase. You will have the time to research the products and 
more closely read the reviews and rumors. 


You can now start making tentative decisions as to what product 
you want, whether to buy a new, old or refurbished model, and 
what configuration you desire. 


You should also start to look at what prices are available, what 
deals start to appear, and which sellers appear to be the best for 
you.


Luck favors the prepared mind - or something like that. Having 
done this preliminary work might enable you to get some great 
discounts on a great configuration. You will be able to recognize a 
great deal when one pops up.


The new or last year’s question 

if you need the latest model, there’s no question. Similarly, if you 
are an early adopter, there’s no question. But for many of us, last 
year’s model is often a tempting rational choice, except that Apple 
often puts in new capabilities that the older models can't handle. 
And why be rational all the time.


And the older models are typically available at discount.


To add to the complexity, there is the question of refurbished 
models, those which have been returned to Apple or a seller. 
Those from Apple have been fixed, tested thoroughly, and typically 
carry a one-year warranty. Those from sellers have been typically 
fixed and some carry a warranty. The discounts can be as much as 
10 to 20%, but you have to check carefully, particularly with 
respect to the exact model number so you're getting the product 
you want.


For more information go to www.wikihow.com/Buy-a-Mac-
Computer-at-a-Discount. For Apple refurbished products, go to 
www.apple.com/shop/browse/home/specialdeals.
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What’s the return policy 

I won’t buy a product from a seller unless it offers a no-questions-
asked return policy. You haven’t had the opportunity to use a 
product and should be allowed to return it. Apple has a 14-day 
return policy when you purchase the Mac directly from it.


Also, make sure you understand if there are restocking fees what it 
is. These can be hefty. 


Upgrades 

I think we are seeing less opportunity to upgrade Apple products 
with additional RAM, hard drives, SSD’s and other equipment. 
Nonetheless, there are some opportunities and so it pays to see if 
you can save money by installing them after purchase.


Of course, you need to have the right tools and skills. YouTube 
videos can be a great help.


Andrew Orr posted the following article to macobserver.com on 
March 1, 2017. tinyurl.com/lxwqenb. © The Mac Observer, Inc. 
Andrew is a freelance writer and amateur photographer from 
Michigan. 

macOS Sierra: Quickly Restore Safari Tabs 
By Andrew Orr 
When you’re browsing the web, it’s inevitable that you’ll 
accidentally close a tab. Even if on purpose, you may still want to 
re-visit the page you were looking at. Instead of going into your 
Safari History, there is a quicker way to restore Safari tabs.


Restore Safari Tabs With Keyboard 
macOS has long had a keyboard shortcut for restoring Safari tabs. 

All you have to do is press ⌘  + Shift + T. This works in old 
versions of OS X, but in macOS Sierra, you can hold down ⌘  + 
Shift, and press T multiple times to restore multiple tabs. 


Safari on macOS Sierra 
Using this keyboard shortcut has saved me plenty of time when 
using Safari, and I hope it helps you too.
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MLMUG April 8, 2017 Meeting Minutes

By Mark Bazrod, Secretary 
Maria Arguello, our President, opened the MLMUG meeting at 9:15 
AM at the Hershey’s Mill Community Center near West Chester. 
There were about 33 attendees.


Main Presentation - Dave Hamilton.  

BETTER WAYS TO WI-FI; CHOOSING A ROUTER IN 2017 

Dave Hamilton gave a truly outstanding presentation on Saturday. 
Everyone should not only read these minutes, but should 
download the PDF of his presentation which is on the MLMUG 
website (tinyurl.com/kdfklsq). because at some point in the future 
you’re going to want to know more about Wi-Fi and routers. His 
presentation will be a great way to start. You want to go again one


Dave co-founded Mac Observer 18 years ago and has been its 
President ever since. He also produces a weekly podcast with 
John Braun entitled Mac Geek Podcast. Get the app in the App 
Store. He lives in New Hampshire and made a 6-7 hour drive to 
come down to speak to us. 


There are a number of different router specifications identified by 
number 802.11 followed by b, a, g, n, and ac. The number 
indicates the router speed, bandwidth, and distance capabilities. 
The oldest, the 802.11b has a maximum speed of 11 Mbps  
(megabits per second). The next to latest, the n, has a maximum 
speed of 150 Mbps. The latest, the ac, has a maximum speed of 
433 Mbps.


If you’re going to buy a new router, get the 802.11ac model. 
Also, get at least a dual-band router, i.e., one that supports both 
5 GHz and 2.4GHz frequencies. The 5 GHz choice has a 
somewhat shorter range and supports a, n, and ac. Recent Apple 
devices support 802.11ac.


Your iDevice and Mac decide which radio frequency to pick based 
upon which has the strongest signal. However, they are clueless as 
to what other devices the router is supporting.


Band steering (also called Smart Connect). The router helps your 
devices decide which of the 2.4 or 5 GHz frequencies to use. 
Band steering is important and you want your router to have it. 
Both frequencies must have the same name. To rename the 
frequency, go to the vendor site to see how to do it. 


Streams. Descriptions of routers are 2x2, 3x3, or 4x4. This tells 
how many antennas pairs there are - 2, 3, or 4. The speeds 
indicated above are per antenna. Streams are speed multipliers. 
They indicate how many times the basic speed of the router can 
be increased. For instance, a router with a basic speed of 150 
Mbps and a 2x2 string will have a maximum speed of 300 Mbps. 
Thus, this description is extremely important. The iPhones 6 and 7 
support 2 x 2; the iMac, 3 x 3. Get at least 3x3.


Do number of visible antennas matter? Somewhat. The visible 
antennas are receiving antennas. There are an equal number of 
sending antennas inside the router.


Beamforming is a processing technique which attempts to obtain 
the optimal path between two devices. The router and device talk 
to each other so you get the best antenna connections. This is 
another important factor and your new router should have 
beamforming.


MU-MIMO (Multiple User MIMO) v. SU-MIMO (Single User 
MIMO). MIMO means multiple in, multiple out which in English 
means the router has several sending and receiving antennas. In 
MU-MIMO the router broadcasts signals from a number of 
antennas to multiple devices simultaneously. In SU-MIMO the 
router broadcasts to one device at a time. Wi-Fi bandwidth gets 
shared among various devices from one common pool. The more 
devices you connect, the less bandwidth is available for each one. 

�7
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iPhone and Mac don't support MU-MIMO. To use MU-MIMO all 
devices must support it. Don't worry about it because SU-MIMO is 
all you can use with Apple products.


The direction of the antennas can be manually adjusted. You 
should do whatever the vendor says, but if there are no directions, 
point one antenna up, a second sideways and the third in a 
different direction.


Using a nonwireless connection (normally Ethernet) between the 
router and the device means you free up the wireless bandwidth of 
the router. 


Quality of service (QoS) is extremely important. It means that one 
device will not hog bandwidth. Think about simultaneously backing 
up photos to iCloud and data to CrashPlan.


You definitely want QoS, but Apple has never made a device with 
QoS. As a result, demanding users don't tend to use Apple 
routers.

 

Cable modems limit speed to what you pay for. Awful for 
upstream. Combined routers/modems normally don't have QoS 
because they don’t have a fast enough processor.


What about ISP routers? If you buy your own router, get the best 
router you can afford and you will probably keep it two to four 
years. If you rent your router from your ISP, try to have it replaced 
annually as better routers are released. 


Standalone routers 

Dave’s favorite router is the Synology RT2600ac. $225. A 4 x 4 
dual-band router with many great features, including QoS, band 
steering, and a great web interface. Truly awesome. It’s Cloud 
station is better than Dropbox and is free!

TP-Link Archer C7. 3x3. $125.

Netgear R7000 $159.


Netgear R8500 $349. Dave used this router before he switched to 
Synology. .


Mesh Networks. These are multiple Internet access points 
working together. One will be a router;  the rest will just be access 
points, although they look like multiple routers. They will have the 
same network, encryption, and password, and are all intelligently 
managed from one interface. They are different from range 
extenders.

 

The benefit is coverage,. multidevice throughput (similar to MU-
MIMO as each device seeks to connect to a different access 
point), you set it and forget it, and intelligent operation. Apple 
products support mesh networks so act like MU-MIMO  even 
though they don’t support it. The mesh replaces your router. Your 
home is bathed in Wi-Fi!

 

Dave says hardware is more important than software, but software 
is extremely important. Software is evolving. Some networks are 
cloud managed while others are locally managed. It would be great 
if you can put Ethernet in your walls since Ethernet is faster than 
wireless.


Dave’s current favorite mesh network is  Eero. Dual band. 2x2 
radios. It has the most mature software, the best QoS is built in, 
and it support Ethernet. The cost is $399 for a 3 pack of Eero 
devices. 


�8
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The Netgear Orbi is a tri-band mesh network. The cost is $299 for 
2-pack. It’s very good for distance, particularly if you have a 
separate building. However, it doesn’t have QoS. 


The Linksys Velop network is the most expensive mesh network 
and is sometimes slow. Future software updates could fix the 
problems, but he would not buy it yet.


Google Wi-Fi , but no QOS. The cost is $299 for 3-pack.

 

LUMA. Basic. $299 for 3-pack. Limited features.


Ubiquity.i’s Amplify HARD DRIVE. $349 for 3-pack. Big in 
corporate world. 3x3, but you can buy separately ($125) and 
connect to router. Best range extender you can get. Semimesh. 


MoCa (Multimedia over Coax Alliance) is using Ethernet Internet 
over Coax. Bonded MoCa has a maximum speed of 800 Mbps.. 
Fios uses MoCa. It sends Ethernet over Coax cable. 


Powerline. Sends Ethernet over house wires. Maximum speed is 
about 100 Mbps. 


Ask your ISP for a MoCa filter if you have a TV problem. 


Older wireless printers might have an access problem with mesh 
networks. 
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SPEAKER ROSTER FOR 
MLMUG'S 2017 MEETINGS 

January 14	 	 Mark Bazrod - Siri

February 11 	 	 Stan Horwitz - MacBook Pro 

March 11 	 	 Lisa Rysinger - VR 360

April 8		 	 Dave Hamilton - Better WiFi

May 14 	 	 Michael Inskeep - Securing Your Mac II

June 11 	 	 Picnic

July	 	 	 Recess - Summer

August	 	 Recess - Summer

September 9 	 Paul Del Rossi - Virtual Machines

October 14 	 	 Fiona Keyes – iPhotography Part II

November 11 	 Bob "Dr. Mac" LeVitus

December 10	 Pot Luck Brunch, Swap Meet, Members’

	 	 	 Show & Tell, & Election of Officers
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Brian X. Chen posted the following article to nytimes.com on 
January 25, 2017. tinyurl.com/l3s8cym. © The New York Times 
Company. He is a technology reporter at The New York Times, 
author of Always On, and has been a technology commentator on 
a number of radio and television programs. 

Dumping a Bad App? Tips for a Painless Breakup 
By Brian X. Chen  

EVERYONE is familiar with this scenario: 
An app you once loved no longer brings 
the same joy. It’s gotten buggy over time, 
or an update transformed it to the point it 
became unusable.


Chances are you thought about calling it 
quits. But after years of sharing your 
personal data with this app, you probably 
gave up and stayed in this stale 
relationship. You put up with the 
productivity-killing bugs and odd design 
changes because moving to a new, 

potentially better app felt harder than sticking with the bad one. 

Take Evernote, the note-taking app. After nearly a decade 
attracting millions of users, the company last year severely 
restricted free use of its software while raising prices for its plans 
by as much as 40 percent. This month, Evernote also released a 
redesign for its mobile app, which users complained was bloated 
with unnecessary features that have made note taking too 
complex. 


Even so, people have stuck with Evernote partly because taking 
their notes elsewhere is hardly easy.


”We understand those kind of changes don’t make everyone 
happy,” said Greg Chiemingo, an Evernote spokesman. “In fact, 
we’ve seen continued growth of paying customers over the last 
two years.” 

People deserve better than this. Every day you stay with a bad app 
is time you could be spending with a superior product that will 
make life better. Here are my tips, based on interviews and 
personal experience, for a clean break.


When to Call It Quits 
No app is perfect, but you have to draw the line somewhere. The 
problem is, you may be in such a rut that you can’t recognize the 
warning signs.


An obvious one is when an app stops working reliably in a way 
that affects your life. For instance, I called it quits on Apple’s 
Calendar app when I was planning a dinner with friends last month 
and the software sent a calendar invite in Greenwich Mean Time 
rather than Pacific Standard Time. As a result, one person thought 
we were meeting on Saturday instead of Friday and didn’t show 
up. (It wasn’t the first time this happened, either.)  




Phil Libin, center, a co-founder of Evernote, during a staff meeting 
at the company’s headquarters in Redwood City, Calif., in 2013. 
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Brian Fitzpatrick, a former manager at Google who led a team that 
developed tools to help people move their data to and from 
Google, said he dumps an app when it has stopped improving.


“It’s still functioning, but you don’t see any changes in it for a very 
long time,” he said. “It’s sort of a zombie app, I would call it at that 
point.” 

Another sign that it’s time to move on is when you have nobody to 
talk to. Many popular apps for tasks like note taking, photo 
management and word processing are connected to social 
networks, or people you can share data with. If an app’s audience 
is a ghost town — like Yahoo’s photo-sharing app, Flickr, which 
sank in popularity after mobile photo-sharing services like 
Instagram emerged — then it’s probably time to leave.  

Yahoo did not immediately respond to a request for comment 
about Flickr.


Getting Out 
The hardest part of breaking up with an app is moving your data. 
So as a rule of thumb, save a backup copy of your data so that 
you can export it into a new app. Then carefully search for a better 
app to suit your needs.


As a safety measure before changing apps, you should always 
keep extra copies of your data somewhere, whether it be in the 
cloud with a service like Dropbox or on a physical hard drive. 

Some companies deliberately make exporting your data difficult 
because they want you to stick around.


“It’s sort of like moving into an apartment and finding out at the 
end of the lease you can’t take your furniture and your books with 
you,” Mr. Fitzpatrick said.


Evernote is a good example. It includes an “Export notes” feature, 
but it only lets you export notes into two formats that are 
compatible with just a few other note-taking apps. Microsoft’s 
note-taking app OneNote, along with Apple’s Notes app, can 

easily import Evernote records. But if your app of choice is 
something else, such as Google Keep, you will have to manually 
paste your notes in the new app. 

Flickr is also difficult to part ways with. Getting out your photos 
requires lots of manual labor: You have to download all the photos, 
which can take a significant amount of time if you have thousands 
of high-resolution images, and then upload them to a new photo 
service.


When companies don’t provide convenient tools to export your 
data, look elsewhere by doing a quick web search for solutions. 
There are plenty of people in the same boat as you, and chances 
are they have written scripts, or lightweight programs, to 
automatically pull out your data for you. 

If there is no convenient way to export your data, sometimes it 
doesn’t hurt to just take out what is most important to you. 
Perhaps you don’t need five-year-old notes from Evernote 
anymore, so you could just manually paste your latest memos and 
get a fresh start with a different app. 

Finding a New App 
On the bright side, you can learn a lot from a tough breakup with 
an app — which can be especially useful when looking for a 
replacement.


The biggest lessons: Pick a tool that supports a wide array of 
formats instead of proprietary ones. And before you commit to a 
new app, make sure it is as easy to get out as it is to get in.


Ditching Apple’s Calendar app was fairly easy. All my calendar 
data was already stored online and Apple’s app supports 
calendars from multiple online services including Google, 
Microsoft and Facebook. The key was finding an app that also 
supported those services but performed better. 

After testing several apps, I decided that Fantastical 2, a new app 
with a cleaner interface for getting a glance at calendar events, 
was the best one. Once Fantastical 2 was installed, I added my 
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Google calendar accounts to load all my events into the app.


Mr. Fitzpatrick recently decided to cut ties with Google Voice, the 
search giant’s calling and texting service, because it had remained 
unchanged for years. So he made backups of his call history, text 
messages and address books using Google Takeout, a web tool 
that he helped develop for easily downloading personal data 
stored on Google services. Then he switched to Signal, the 
encrypted messaging service, which has more modern features for 
messaging and phone calls, and disconnected his Google Voice. 


Google said it updated Google Voice on Monday with photo 
sharing and group messaging. But that was too late to keep 
people like Mr. Fitzpatrick. 

“A lot of it comes down to, How interested are you in change?” he 
said.


Roman Loyola posted the following article to macworld.com on 
April 18, 2017. tinyurl.com/kntf4pb. © IDG Consumer & SMB. A 
Senior Editor at Macworld, he has covered technology since the 
early 1990s. 

GarageBand, iMovie, Keynote, Pages, and Numbers 
are now free for Mac and iOS 
That one guy who bought Pages for $10 last week is going to be 
pissed. 

By Roman Loyola  
As first spotted by MacRumors, Apple on Tuesday updated 
GarageBand, iMovie, Keynote, Pages, and Numbers for Mac and 
iOS, so that those apps are now free. Before today, those apps 
were free to users who bought a new Mac, iPhone, or iPad, and the 
free download was a one-time event. Now the apps are free all the 
time.  
Before Tuesday, the iOS versions of Keynote, Pages, and Numbers 
were $10 each, while the Mac versions were $20 each. On iOS, 
GarageBand and iMovie were $5 each, while on the Mac, 
GarageBand was $5 and iMovie was $15. You can save a 
considerable amount of coin if you’ve put off buying any of these 
apps. 


Apple did not officially announce the price changes, nor did the 
company issue a policy statement to users who recently paid for 
any of the apps. The free versions are now available on the iTunes 
Store and the Mac App Store.
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The following article was posted by Jeff Butts to MacObserver.com 
on March 24, 2017. tinyurl.com/l4lfa7h. © The Mac Observer Inc. 
He is pursuing a master’s in Computer and Information Systems, 
but he’s been working on computers since before he ever thought 
about teaching. 

Customizing the Services Menu Helps You Optimize 
macOS 
By Jeff Butts 
It’s an oft-neglected feature of your Mac. It lies there, waiting for 
you to use it and customize it, but maybe you’ve forgotten it’s 
there. Or perhaps you just don’t know what it’s capable of. 
Whatever the case may be, the macOS Services menu available 
when you secondary, or right, click on your Mac has a lot of 
potential, if you know how to customize it. You can really optimize 
macOS with a few tweaks in Services.


Do you know everything in your Mac’s toolbox? Let’s explore the 
Services Menu and how you can customize it. 

What Is macOS Services? 
Whether you’re typing in a document or surfing the Web, plenty of 
options appear when you secondary, or right, click, a selection. 
That’s where you can cut, copy, or paste text, but you can also 
access the Share Sheet extensions and other tools. What you 
might have neglected, though, is the Services menu, which opens 
up another world of options to optimize macOS. You’ll see several 

default choices there, but you can add even more to Services, if 
you customize the menu.


Here’s one example of what you might see in the Services menu 

Okay, So How Can I Customize the Services Menu to 
Optimize macOS? 
To begin customizing your Services menu and optimize macOS, 
you’ll need to go into System Preferences. The fastest way to get 
there is to click the Apple icon in the top left of your screen, then 
click System Preferences. From there, click on Keyboard. 
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When the Keyboard preferences pane shows up, click on 
Shortcuts. 


Next, click on Shortcuts 
Finally, you should click on Services, and then scroll through the 
available choices to enable what you think you might use the 
most. Your options will vary from what I have, since you likely have 
different apps installed than I do. Many third-party apps provide 
their own choices here. 





Finally, click on Services, and customize away 

Harness Even More of the Power of Your Mac 
When you customize (and then use) Services, you’ll be able to 
harness even more of the power of macOS. You can speed up 
your workflows considerably, making yourself much more 
productive and efficient on your Mac. It’s just one more way of 
showing what a power user you are.
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Tom Nelson updated the following article on lifewire.com on April 
01, 2016. tinyurl.com/hxtpfdg. .© About, Inc. He is a consultant 
and writer providing Macintosh training, advice, and support. He 
has written hundreds of articles, tutorials, and product reviews. 

Restore Smart Searches to OS X Finder's Sidebar 
How to Get Searches Back in the Finder's Sidebar 

Smart Folders and Saved Searches can still populate the Finder's Sidebar. 

By Tom Nelson  
The Finder sidebar has undergone quite a few changes since OS X 
Snow Leopard. While we hope that the Finder sidebar will receive 
some badly needed refinements in the near future, there is no 
reason to wait to gain back some of the productive tools that were 
lost with the release of OS X Lion and subsequent versions of OS 
X. 


Lion's sidebar eliminates the entire Search For group. This was a 
handy area in the sidebar that let you quickly find documents and 
applications you worked on or used today, yesterday, or during the 

past week. 


It also listed all of the images, movies, and documents stored on 
your Mac.


Apple attempted to replace the sidebar's Search For section with a 
single entry in the Favorites section called All My Files. All My Files 
displays images, PDFs, music, movies, documents, and more, all 
in a single Finder view that is split up by the various categories. 
Apple wants us to use the All My Files entry so much that it made 
All My Files the default view when you open a new Finder window. 
From what I have seen and heard, changing the default view 
seems to be one of the first changes most Mac users are making 
to the Finder, because they prefer the Finder to open on their 
desktop, home directory, or documents folder. 


The Search For section of the sidebar is so helpful, it was one of 
the first features I checked when Apple released OS X El Capitan. I 
wanted to make sure that Smart Folders, and the ability to save 
searches and add them to the Finder’s sidebar, still worked. 


Thankfully, they do; you can still create your own custom version 
of the older Search For sidebar section using these instructions.


Restore Smart Searches to the Sidebar 
While you can't restore the old Search For sidebar section, you 
can get back the same functionality through the use of Smart 
Folders, which can be saved to the Finder's sidebar.


We're going to use the Finder's ability to create Smart Folders, 
which let you organize files by what they have in common, instead 
of where they are located in the file system. Smart Folders use 
Spotlight to compile a list of items based on the search criteria you 
set up. 


Smart Folders don't contain the actual files or folders; instead, 
they hold links that point to the location where the items are 
stored. For the end user, clicking an item in a Smart Folder has the 
same effect as clicking the item in its actual storage location. The 
only real difference is that while an item in the Finder's file system 
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can only be located in a single place, an item can be shown in 
multiple Smart Folders. 


Creating a Smart Folder 
Make sure the Finder is the front most application, either by 
opening a Finder window or by clicking on your Mac's Desktop. 
We will recreate the Today Smart Search (see image) from the pre-
Lion Finder sidebar as an example. 

1. From the Finder menu, select File, New Smart Folder.

2. A Finder window will open, with the search pane open.

3. Select the area to search; for this example, click the This Mac 

item.

4. On the far right side of the search pane, click the plus (+) 

button.

5. The Search Criteria area will display, showing various buttons 

and fields, depending on the search criteria you chose.

6. Click the first search criteria button and select 'Last opened 

date' from the drop-down menu.

7. Click the second search criteria button and select 'Today' from 

the drop-down menu.

8. Hold down the Option button and click the '…' button to the 

far right of the search criteria you just set up.

9. Two new search criteria rows will display.

10. In the first new row, set the single button to 'None'.

11. In the last row of the search criteria, set the first button to 

'Kind' and the second button to 'Folder.'

12. The search results will display.

13. Set the search order to Last Opened by clicking on the Last 

Opened column in the search results (you may need to scroll to 
see the column).


14. The finished Smart Folder search criteria should look like this 
(I've placed single quotes around the button text):


15. Search: 'This Mac'


16. 'Last opened date' is 'today'

17. 'None' of the following are true

18. 'Kind' is 'Folder'

Save the Resulting Search as a Smart Folder 
1. Click the Save button on the far right of the search pane.

2. Give the Smart Folder a name, such as Today.

3. You can leave the 'Where' setting at the default location.

4. Place a check mark next to the Add to Sidebar box.

5. Click the Save button.

6. The Today item will be added to the Favorites section of the 

Finder Sidebar.


Recreating the Search For Items 
The six Search For items in the pre-Lion sidebar were Today, 
Yesterday, Past Week, All Images, All Movies, and All Documents. 
We have already created the 'Today' item for the sidebar. To 
recreate the remaining five items, use the instructions above, along 
with the following search criteria.


Need help creating theses smart searches? I've included an image 
gallery that details the steps in creating the various smart 
searches. 


Yesterday 
Search: 'This Mac' 

'Last opened date' is 'yesterday' 

'None' of the following are true 

'Kind' is 'Folder' 


Past Week 
Search: 'This Mac' 

'Last opened date' is 'this week' 

'None' of the following are true 

'Kind' is 'Folder' 
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The remaining three items only need the first two rows of the 
search criteria. You can delete the unneeded rows by clicking the 
minus (-) button to the far right of each row.


All Images 
Search: 'This Mac' 

'Kind' is 'Image' 'All' 


All Movies 
Search: 'This Mac' 

'Kind' is 'Movie' 


All Documents 
Search: 'This Mac' 

'Kind' is 'Documents' 


With those six Smart Folders added to your Finder's Sidebar, you 
have successfully recreated the original Search For section of the 
pre-Lion sidebar. 
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The following article was posted to osxdaily.com on January 31, 
2017. tinyurl.com/n8nmkla. © OSX Daily. Try the site. Lots of tips 
and good info. 

How to Reset a macOS Sierra Password 

Need to reset the password on macOS Sierra? Maybe you forgot 
your primary admin user account password or maybe you’re 
working on someone elses Mac and you need to gain access to it. 
We’ll show you the easiest way to reset the password on a macOS 
Sierra based computer. 

To be clear, this allows you to reset any password for any user on a 
MacOS Sierra computer, including for the admin account. Before 
beginning, keep in mind that internet connected Macs running 
Sierra and other prior versions of Mac OS can also reset a 
password by using an Apple ID after incorrectly entering a 
password a few times, which may be a better approach for some 

users. For earlier MacOS versions you can also follow these tips 
for handling a forgotten Mac password meaning you’re not out of 
luck if you don’t have Sierra or a modern Mac OS release.  

Resetting a macOS Sierra Password 
This is the simplest way to reset a password on a MacOS Sierra 
computer: 

1.	Reboot the Mac, as soon as the screen turns back on or you 
hear the boot chime sound, start holding down COMMAND 
+ R keys concurrently to boot into Recovery mode


2.	At the “MacOS Utilities” screen, pull down the “Utilities” menu 
and choose “Terminal”


3. When Terminal loads, type the following exactly:


resetpassword
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4. Hit the return key to launch the Reset Password tool, then 
choose the user account or admin account you want to 
reset the password for


5.	Enter a new password, confirm the new password, set a 
password hint (recommended) and then click on “Next” to 
set the new password for the account in question 


6.Choose to “Restart” the Mac and when the Mac boots up, use 
the newly reset password to login to the computer


That’s all there is to it, the password will have been reset to 
MacOS for the user account you chose. 

While this is fairly advanced, it’s also relatively easy. If the ease of 
this concerns you at all, you can make things more secure and 
prevent the easy password resetting by setting a firmware 
password on the Mac, but do be forewarned that if you forget the 
firmware password it can be a much more significant ordeal. Using 
and enabling FileVault for disk encryption can also be beneficial to 
users who are generally concerned about data security and 
privacy.  
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Melissa Holt posted the following article to macobserver.com on 
November 7, 2012. tinyurl.com/z67jzxy. © The Mac Observer, Inc. 
She is an Apple Consultant who lives and works along the Front 
Range in Colorado. 

A Better Way to Paste Copied Text 
By Melissa Holt 
Sometimes you gotta paste text in so that it looks exactly like the 
original you copied. Sometimes, though, you want it to match the 
formatting you've got going on in the rest of your document, and it 
can be really really REALLY time-consuming to go through and 
reformat all the pasted text you've inserted. Enter Apple's lovely 
solution to that issue—Edit > Paste and Match Style (or Option-
Shift-Command-V). 


You can use this feature in a lot of different programs around your 
Mac, like Mail, Pages, Notes, and even Word (it's labeled Edit > 
Paste and Match Formatting in Word 2011). 


Here's what effect it has. I copied the headers for a TMO article, 
and it looks like this if I use the regular Edit > Paste (Command-V) 
menu item while I'm composing a message in Apple Mail: 


And here's how it looks using Edit > Paste and Match Style: 


Paste and Match Style forced the text to conform to my regular 
Mail font, size, and color, and it stripped out the extraneous HTML 
(such as the link to the article that got copied with the 
headline). Neat, right? This is obviously pretty useful when you're 
pulling information from different sources but want to make 
everything look tidy. 

As a bonus tip, here's another way to paste text in Apple Mail that 
I also use quite often. It's Edit > Paste as Quotation (Shift-
Command-V). Here's what it does to our headline: 


As you can see, it sets it off from the text I typed around it by 
increasing what's called the Quote Level of the pasted item, 
indicated by the blue bar to the left of that text.


If you want to change that Quote Level manually, you can select 
some text and choose Format > Quote Level > Increase, which 
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can be applied multiple 
times to make the level 
increase even further. Use 
this to really make your 
emails look professional 
when you ' re quot ing 
different sources. 


 

What? I said you could make your emails look professional. I didn't 
say anything about mine. 


�21



                 VOLUME 28, NUMBER 5                    MAIN LINE MACINTOSH USERS GROUP                    MAY 2017 

Glenn Fleishman posted the following article to macworld.com on 
April 14, 2017. tinyurl.com/qevocvk © IDG Consumer & SMB. He is 
a Senior Contributor to Macworld and a regular contributor to the 
Economist, Fast Company, and Boing Boing. He appears regularly 
on public radio to discuss the tech industry. 

How to fix a “can’t be moved” permissions problem 
on your Mac 
What to do if you can’t save a file in macOS. 

By Glenn Fleishman 

Noelle Oliveira says her Mac isn’t letting her save files from 
several different programs. She consistently receives the 
error (with various filenames and folder locations): 

“filename” couldn’t be moved because you don’t have 
permission to access “folder”. 


macOS says she needs to change permissions on 
Desktop, but I’d wager most Mac users haven’t had to 
wrangle with this. Permissions are a Unix-level property 
attached to files (including apps) and folder that control the 
rights a given user or system agent has to read, write, 
execute, or act in other ways upon a file or folder. 

In the old days, we had to muck about with permissions all 
the time. Disk Utility even had a 
Repair Disk Permissions options 
to fix system settings that might 
have gotten out of whack. (It 
was removed in later releases of 
the app because it was no 
longer necessary.) 

In fact, honest to goodness, I 
can’t recall the last time I had to 
modify permissions on files 
created through Mac apps or by 
macOS. (I sometimes use 
Terminal and have to mess with 
file permissions behind the 
scenes for command-line apps.) 

If permissions are unfamiliar to 
you, it’s fortunately accessible—
as Apple says in the dialog box
—by selecting one then 
choosing File > Get Info. To 
modify multiple items, hold 
down Option and select File > 
Show Inspector. Because Apple 
provides no further instructions, this might leave many 
newer users at sea. (And, by the way, the Desktop folder 
referred is the one in the top level of your home directory. 
Select Go > Home in the Finder, and you’ll see it there.)  

In the Sharing & Permissions area of either the Get Info or 
Multiple Item window, you should see your account in the 
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Name column and (for regular documents) Read & Write 
under the Privilege column. For example, I show up as 
“glenn (Me)”, my Unix user name for my account, under 
Name. 

If you don’t see yourself, follow these steps: 
1. Click the lock icon in the lower-right corner and enter 

your password (or that of an administrative 
account, if your user account isn’t set with admin 
privileges).


2. Click the + sign at lower left.

3. Select yourself from the Users & Groups list and click 

Select.

4. In the Privilege column next to your name, choose 

Read & Write.

5. If it’s a folder and you want to make sure everything 

within the folder down to the lowest level also has 
the same access (typical for document), from the 
gear item, choose Apply to Enclosed Items and 
then confirm by clicking OK.


If you do see yourself, but Read & Write isn’t selected: 
Follow steps 1, 4, and 5 above.  

Some readers have found this problem occurs even if the 
permissions are correct on the destination folder, however, 
and forum searches lead me to believe that can result from 
the wrong permissions on a hidden Autosave Information 
folder used by Apple’s apps for interim versions of 
documents you’re working on before you save them under 
a name in a different location, or between you explicitly 
choosing File > Save in apps that require that.  

To fix the Autosave Information problem, follow these 
steps: 

1. Open your user Library folder in the Finder by selecting 
Go > Go To Folder and entering ~/Library


2. Select the Autosave Information folder.

3. Choose File > Get Info.

4. Check the Sharing & Permissions section. If your name 

doesn’t appear or it appears without the correct 
permissions, follow the steps above, making sure 
to use step 5, as you want all enclosed items to 
also be fixed.


Ask Mac 911 
We’ve compiled a list of the questions we get asked most 
frequently along with answers and links to columns: read 
our super FAQ to see if your question is covered. If not, 
we’re always looking for new problems to solve! Email 
yours to mac911@macworld.com including screen 
captures as appropriate. Mac 911 can’t reply to—nor 
publish an answer to—every question, and we don’t 
provide direct troubleshooting advice.  
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The following article was posted by Jeff Butts to MacObserver.com 
on April 18, 2017. tinyurl.com/l37ns85. © The Mac Observer Inc. 
He is pursuing a master’s in Computer and Information Systems, 
but he’s been working on computers since before he ever thought 
about teaching. 

The 5 Best Terminal Commands for Your Mac 
By Jeff Butts 
You can do quite a bit with your Mac through the user interface 
(UI). Still, that’s just a snapshot of the true power your computer 
holds. To really unleash the power of your Mac, you need to visit 
the Terminal and learn how to use it. Let me give you my five 
favorite Terminal commands for macOS. Most of these will also 
work on earlier versions of OS X, by the way.


� 


I added the message to my login screen using one of my favorite 
Terminal commands 

Important Commands For the Terminal 
Before we dig deep into the command line, let’s look at some 
important commands you should know.


•	 pwd – Displays the directory you’re currently in


•	 cd – Change directory to another one. For example, if I’m in 
my Home directory (/Users/clefmeister) and type cd 
Downloads, I’ll be taken to my Downloads folder. On the other 
hand, typing cd .. will take me to the previous directory in the 
hierarchy.


•	 sudo – This command authenticates you as an 
administrator for certain commands that need elevated 
permissions.


•	 defaults – The defaults command provides access to the 
macOS user defaults system, which stores details like whether 
hidden files are displayed, what happens when you press and 
hold a key on your keyboard, and quite a bit more.


•	 killall – This ends all of the processes named whatever you 
specify. Use this sparingly, and only when you really mean it.


Those are the primary commands we’ll be using. Let’s move on to 
my top five Terminal commands for macOS.


1. Add a message to your login screen 

Whether you want to remind folks that it’s your computer, not 
theirs, or just add contact information in case your treasured 
MacBook Pro is lost, this one is a good tool. Just type the 
following, replacing my message with yours:


sudo defaults write /Library/Preferences/com.apple.loginwindow 
LoginwindowText “Stay out! This is Jeff’s Mac, not yours.” 

2. Stop Your Mac From Going to Sleep 

If you’re running an app that’s going to take a while to finish, or 
recording your screen, you might want to stop your Mac from 
going to sleep. Sure, you could change your energy saving 
preferences, but this is much easier. Just type this command and 
your Mac will stay awake until you cancel it.


caffeinate 

When your task is done and you’re ready for your Mac to sleep 
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again, just type Control-C in the Terminal window to end the 
caffeinate task. 


3. Add Spaces to the Dock 

� 


You can have nifty spaces in your Dock using this Terminal 
command 

If you want to have cool spaces between different groups of apps 
on your Dock, that’s easy to do. Just issue these commands and 
you’ll get a new spacer tile that you can move to the spot you want 
it to live. This is great for providing more visual organization to your 
Dock.


defaults write com.apple.dock persistent-apps -array-add ‘{“tile-
type”=“spacer-tile”;}’  

  killall Dock 

Repeat the commands for as many spaces as you want. If you 
want to get rid of a space tile, just drag it out of the Dock until it 
goes poof.


4. Turn On Key Repeating for Your Keyboard 

When you hold down on a key on your Mac, the default action is 
for it to display special characters you can type with that key. I 
talked about this in a previous article about how to type accented 
characters. 


� 


Accented characters are nice, but sometimes you want the 
keyboard to repeat letters instead 

Sometimes, though, you want to go back to the old behavior of 
having a long keypress result in repeated characters. That’s easy 
enough to do using this command:


defaults write -g ApplePressAndHoldEnabled -bool FALSE 

To reverse it, simply issue this command:


defaults write -g ApplePressAndHoldEnabled -bool TRUE 

5. Hide Stuff From the Finder 

Let’s say you’ve got a folder you want to keep secret. For 
example, your collection of Christmas lists and receipts is 
something you might not want your significant other or children 
seeing.


You can hide folders using a Terminal command


You can hide that folder without any trouble, right from the 
Terminal. Just type this command into the Terminal:


chflags hidden “/Users/clefmeister/Desktop/Folder to Hide” 
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The folder is still in my Desktop directory, but now it’s hidden


To undo what you’ve just done, simply go back to Terminal and 
type:


chflags nohidden “/Users/clefmeister/Desktop/Folder to Hide” 

Bonus Tip – Drag Folder or File Names to the Terminal 

That’s right. You don’t have to type out that long folder name you 
want to hide. Just type in the chflags hidden command, drag your 
folder into the Terminal window, and watch the magic happen. 
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The following article was posted by Jeff Butts to macobserver.com 
on March 3, 2017. tinyurl.com/mst8tet. © The Mac Observer Inc. 
He is pursuing a master’s in Computer and Information Systems, 
but he’s been working on computers since before he ever thought 
about teaching. 

Get Your New Mac up and Running with These Tips 
By Jeff Butts 
So, you just brought home a shiny new Mac. You’ll find that your 
new computer is mostly ready to go out of the box. Still, there are 
a few things you should take care of before getting too settled in. 
These steps will help make sure you get the most out of your 
purchase, especially if you’re new to Macs.


If you’re replacing an older Mac, you might want to restore your 
Time Machine backup first, then look through these tips to make 
sure you haven’t missed anything. 


It’s important to take the time to set up your new Mac right. 

Update Your Mac’s Software 
When you first power on your Mac and connect to Wi-Fi, you’ll 
probably be asked to run updates. Once you’ve gotten past that 
initial set up, it’s a good idea to check again to make sure nothing 
was missed. Since you’re learning the ropes, Apple makes it easy 
to find the most important parts of macOS Sierra. Click the Apple 
menu in the top left corner of the screen, then click App Store. 

Once there, click the Updates icon to see if there’s anything new 
to install. 


Start Setting Up Your New Mac by Adjusting the 
Scrolling 
Apple has a “natural scrolling” feature on the Mac that is, in my 
opinion, far from natural. Most of us are used to the scroll bar 
following your fingers on the trackpad, or the scroll wheel on your 
mouse. Not so with natural scrolling. Instead, the page follows the 
scrolling, and it’s the opposite of what you might expect. 
Fortunately, it’s easy to fix. 


To change this feature, you need to visit System Preferences > 
Trackpad > Scroll & Zoom for a MacBook or a Mac with the 
Magic Trackpad. If you use a mouse instead, go to System 
Preferences > Mouse > Point & Click. In either location, you’ll be 
looking for an option called Scroll direction: Natural. Uncheck it 
and your trackpad or scroll wheel will behave the way you’re 
probably used to. 


Natural scrolling isn’t so natural. 

Configure Your Time Machine Backups 
This might sound like a hassle, but it really isn’t. It’s also a life 
saver when you suffer that unfortunate hard drive failure. With 
macOS Sierra, backups are easy to maintain, as long as you have 
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a place to store them. Time Machine is a fantastic backup solution, 
so be sure to set it up right away. We’re going to System 
Preferences again, this time to Time Machine. Make sure Back 
Up Automatically is enabled and you have the correct disk 
selected for your Time Machine backups. For redundancy, you 
should also purchase, install, and configure Carbon Copy Cloner. It 
comes with a 30-day free trial, and is only $39.99 after that.


Take the time to set up Time Machine 

More Changes to the Trackpad May Be In Order 
If you purchased a MacBook or the Magic Trackpad, you may 
want to make additional changes to how it behaves within macOS 
Sierra. For example, you probably want to enable Force Click and 
haptic feedback, if you haven’t already. You should also set up 
how to perform a Secondary Click, the Mac version of right-
clicking the mouse. You can also adjust how much force you need 
to exert to click and how fast the mouse cursor moves when you 
glide your fingers across the trackpad.


Setting up secondary click on your trackpad is easy. 
Mouse users, you aren’t left completely out in the cold here. Go 
back to System Preferences > Mouse and configure Secondary 
Click, along with Smart zoom, if you want that feature. You 
should also investigate More Gestures to set other things to your 
liking.


If you have a mouse, you should configure the secondary click for it, too. 
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Locking Down the Fort 
Next, you’ll want to set up some basic security features. This way, 
if someone swipes your Mac, they won’t have free reign over it. 
Visit System Preferences > Security & Privacy and start off by 
making sure a login password has been set. Next, select Require 
password 5 minutes after sleep or screen saver begins. You 
can also change the length of time, if you want it longer or shorter. 
Once you set this configuration, you’ll be prompted to enter your 
password to unlock your Mac.


Setting your Mac to lock automatically is an important security step. 

This is also a good time to activate your Firewall, making your 
Mac even safer against unwanted intrusions.


eNext, enable your Mac’s Firewall 

Configure Your Email and Social Media Accounts 
Next up, you may want to configure your Mac to connect to your 
email and other online accounts. For example, if you want Google 
Calendar to show up in macOS Sierra’s Calendar app, you’ll need 
to set that up. You can also link with your Facebook, Twitter, and 
LinkedIn accounts from here.


Configuring your Internet accounts is the logical next step. 
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Synchronize With Your iOS Devices 
Got an iPhone or iPad? Of course you do, and you’ll want to link 
them up with your Mac. You can do this via iTunes, or you can 
choose one of these alternatives. My personal favorite is iMazing, 
because of all of the advanced features and tricks it offers. If you 
decide to stick with iTunes, though, you’ll find setting up 
synchronization to be easy and painless.


Synchronizing your iOS device with iTunes is easy 

What Else Should You Do? 
Your new Mac is set up and ready to go, but there’s still more you 
can do. You should visit the App Store and see what’s available. 
It’s also a good idea to settle on your anti-virus software. You 
probably already know what apps you want and need, and now’s 
the time to go get them. Most importantly, though, enjoy your new 
Mac.


Tom Nelson posted the following article to lifewire.com on March 
23, 2017. tinyurl.com/moxlfyc. .© About, Inc. He is a consultant 
and writer providing Macintosh training, advice, and support. He 
has written hundreds of articles, tutorials, and product reviews.


What Really Happens When You Put Your Mac to Sleep? 
Is This The Right Sleep Mode for Your Mac 

By Tom Nelson  
Question:What Really Happens When You Put Your Mac to 
Sleep?  
When I use Mac's sleep mode, what really happens? Is sleep the 
same as safe sleep? Are sleep or safe sleep modes really safe? 
Are there any security concerns? And can I change Mac's method 
of sleeping? 


Answer: Macs have had a sleep mode for saving energy and 
quickly turning back on for quite a while. Yet, questions about 
what happens to a Mac when it sleeps remain perennial favorites 
among frequently asked questions. 

To address questions about Mac's sleep function, we first need to 
know about the various sleep modes the Mac supports. Since 
2005, Apple has provided three basic sleep modes. 


Mac Sleep Modes 
	 •	 Sleep: The Mac's RAM is left powered on while it's 

sleeping. This allows the Mac to wake up very quickly 
because there's no need to load anything from the hard 
drive. This is the default sleep mode for desktop Macs. This 
mode is also called hibernatemode 0.


	 •	 Hibernation: In this mode, the contents of RAM are copied 
to your startup drive before the Mac enters sleep. Once the 
Mac is sleeping, power is removed from the RAM. When 
you wake the Mac up, the startup drive must first write the 
data back to the RAM, so wake time is a bit slower. This is 
the default sleep mode for portables released before 2005. 
This mode is also called hibernatemode 1.
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	 •	 Safe Sleep: The RAM contents are copied to the startup 
drive before the Mac enters sleep, but the RAM remains 
powered while the Mac is sleeping. Wake time is very fast 
because the RAM still contains the necessary info. Writing 
the RAM's contents to the startup drive is a safeguard. 
Should something happen, such as a battery failure, you 
can still recover your data.


Since 2005, the default sleep mode for portables has been Safe 
Sleep, but not all Apple portables are capable of supporting this 
mode. Apple says that models from 2005 and later directly support 
Safe Sleep mode; some earlier portables also support Safe Sleep 
mode. This mode is also called hibernatemode 3 

What Happens When Your Mac Sleeps 
The only difference between the various Mac sleep modes is 
whether the contents of RAM are first copied to the hard drive 
before the Mac enters sleep. Once RAM contents are copied, all 
Mac sleep modes then execute the following functions: 


	 •	 The processor is put into a low-power state.

	 •	 The video output is disabled. Connected displays will enter 

their own low-power state if supported.

	 •	 Apple-supplied hard drives will spin down. Third-party 

internal and external drives may spin down (most do).

	 •	 Optical media drives spin down.

	 •	 Power to the RAM memory is removed (Hibernation and 

Safe Sleep modes).

	 •	 Ethernet port is disabled. This actually depends on system 

settings, which can allow the Ethernet port to respond to a 
WOL (Wake on Lan) signal.


	 •	 AirPort functions, if any, are disabled.

	 •	 USB ports have limited functionality (respond to keyboard).

	 •	 Audio input and output are disabled.

	 •	 Keyboard illumination, if present, is disabled.

	 •	 Expansion card slot is turned off (portable Macs).

	 •	 Modem, if present, is disabled. This depends on whether 

the modem is configured to wake when it detects a ring.


	 •	 Bluetooth is disabled. This depends on the Bluetooth 
system preference, which can allow Bluetooth devices to 
wake your computer.


Security Concerns When Sleeping 
When it's asleep, your Mac is subject to many of the same 
vulnerabilities as when it's awake. Specifically, anyone who has 
physical access to your Mac can wake the Mac from sleep and 
gain access. It's possible to use the Security system preference to 
require a password to access your Mac when waking it from sleep. 
But this only provides a minimum level of protection, which can be 
sidestepped by knowledgeable individuals. 


Assuming you have the Ethernet set not to respond to a WOL 
signal, your Mac should be completely invisible to any network 
access. The same should be true of AirPort-based wireless 
access. 


Third-party Ethernet cards and wireless solutions, however, may 
remain active during sleep. 


Is Sleep or Safe Sleep Safe? 
As mentioned under the Security Concerns section above, your 
Mac is as safe when asleep as it is when awake. It can even be 
slightly safer since network access is usually disabled during 
sleep. 


Safe sleep is much safer than normal sleep because all RAM 
contents are first written to the hard drive. Should power fail during 
sleep, your Mac will recreate the state it was in when it first 
entered sleep. You can see this occurring when you first recover 
from a power failure during a safe sleep session. A progress bar 
will display, as the contents of RAM are recreated from the hard 
drive data. 


Is it Possible to Change Sleep Modes? 
Yes, it is, and it's fairly easy to do with a few Terminal commands. 
You can find instructions for changing sleep modes in the "Change 
How Your Mac Sleeps" article.  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The following article was posted by Jeff Butts to macobserver.com 
on February 28, 2017. tinyurl.com/mst8tet. © The Mac Observer 
Inc. He is pursuing a master’s in Computer and Information 
Systems, but he’s been working on computers since before he ever 
thought about teaching. 

Check This Out – You Can Replace Your Computer 
With Your iPhone 
By Jeff Butts 

Believe it or not, I’m writing and researching this article 
from my iPhone 7 Plus. No, I’m not working on the 
admittedly spacious screen of my iOS device and the 
virtual keyboard. Rather, I’m using my iPhone 7 Plus as a 
desktop replacement, and you can do the same thing, for 
many of the most common tasks people use a PC or 
Mac for these days. Yes, for many tasks, you really can 
replace your computer with an iPhone. 


An iPhone To Replace Your Computer? Really? 
It’s true, you don’t absolutely need a Mac or a PC for 
most of the tasks common to those platforms. Let’s look 

at what most people use their PCs for these days.

	 •	 Surfing the web

	 •	 Creating text documents

	 •	 Working with spreadsheets

	 •	 Crafting slideshow presentations (a la

	 	 Keynote or PowerPoint)

	 •	 Playing solitaire and other games

For things like this, what does a laptop or desktop offer 
that an iPhone doesn’t? A larger screen, a physical 
keyboard, and a mouse. The mouse isn’t really 
necessary, and the keyboard and screen can be taken 
care of with a few accessories. 


What Do I Need? 
From a software standpoint, everything you need comes 
already installed on your new iPhone. You have Safari for 
surfing the web. Pages is an excellent word processor, 
and Numbers is fantastic for spreadsheets. When you 
need to create a slideshow presentation, Keynote is often 
more gorgeous than its Microsoft competitor. 

If you want more, there are definitely other alternatives 
out there. Google Docs, Google Sheets, and Google 
Slides are full-featured and save your files in the cloud. 
You can also turn to Microsoft’s free options for iPhone 
and iPad. Microsoft Word, Microsoft Excel, and Microsoft 
PowerPoint are all available for iOS, if you have an Office 
365 subscription. 

What you will need to buy to complete your setup varies, 
and depends on your preferences. You definitely need an 
external monitor, along with some way to get the display 
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from your iPhone to it. Apple’s Lightning Digital AV 
Adapter works well, but you can also go completely 
wireless by streaming through your Apple TV. 

You’ll also need an external keyboard, one that connects 
via Bluetooth. My personal favorite is the Logitech K760, 
since it pairs with up to three devices and doesn’t require 
batteries. It’s solar-powered, and can even draw enough 
energy from the lights in your home to work just fine. 

The only thing that’s really missing from my setup is the 
aforementioned mouse, which would be nice but isn’t 
absolutely necessary. Read on, though, for how you 
might even get that (without jailbreaking your iOS 
device.)


Getting Fancy With Your Setup 
You can also go hog-wild and get really fancy with your 
setup, if you want a more elegant solution. Coming soon 
is a product cal led DoBox, which is a very 
comprehensive dock for your iPhone or iPad. The DoBox 
will add 32 or 64GB of extra storage, along with USB 
ports and a microSD card slot to your setup. The DoBox 
will also allow you to pair Bluetooth keyboards and mice 
with your iOS device, and has its own HDMI port for 
sending your display to the big screen. There’s even 
more that the DoBox can do, like act as a Wi-Fi hotspot 
and connect via Ethernet. 

Our own Bryan Chaffin covered the Kickstarter campaign 
for DoBox, and the accessory is now available for pre-
order on Indiegogo InDemand. The first batches are 
being tested, and mass production is expected to begin 
soon. 





Aren’t there limits to what I can do with my iOS 
device? 
Naturally, there are limits to how effective an iPhone can 
b e a s a d e s k t o p r e p l a c e m e n t . D u r i n g m y 
experimentation, I found one photography site that 
wouldn’t allow me to download images, and there are 
some functions that there just aren’t apps for. 

For the majority of folks, though, I’d argue that the 
demands placed upon a laptop or desktop computer are 
well within the capabilities of the iPhone or iPad. Of 
course, as our devices keep getting more capabilities, 
the likelihood that we’ll need full-fledged computers 
could grow even slimmer. 

As a postscript, I did find one task that I could not easily 
perform on my iPhone while writing this article. Editing 
and cropping photos to specific pixel heights and widths 
isn’t possible within the most common image editing 
apps. 
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Sam Costello updated the following article on lifewire.com on 
October 17, 2016. tinyurl.com/m5npyxj © About.com. He is a 
consultant and writer providing Macintosh training, advice, and 
support since the Mac Plus. He has written hundreds of articles, 
tutorials, and product reviews. 

How to Configure Push Notifications on iPhone 
By Sam Costello  
What Are Push Notifications? 

There's no need to check 
your apps to see if there's 
something in them that you 
need to pay attention to. 
These days, apps are smart 
enough to let you know 
when there's something you 
need to check out. These 
a l e r t s , c a l l e d p u s h 
notifications, can show up 
as badges on app icons, as 
sounds, or as messages 
that pop up on your iOS 
device's home or lock 
screens. 


This article explains how to configure and use them.


Push Notification Requirements 
In order to use push notifications, you'll need:


	 •  An iPhone or iPod touch (technically it needs to be 
running iOS 3.0 or higher, but that's almost everyone in the world 
these days)

	 •  Apps that support push notifications

	 •  A web connection (3G/4G or Wi-Fi)


While push works on mosts versions of the iOS, this tutorial 

assumes you're running iOS 9. 


How to Configure Push Notifications 
You don't need to enable push notifications. They're enabled by 
default as part of the iOS. All you need to do is choose which apps 
you want to get notifications from and what type of alerts they 
send. Here's how to do that:


1. 	Tap the Settings app to open it


2. 	Tap Notifications


3. On this screen, you'll see all the apps installed on your 
phone that support push. Settings for each app are 
managed separately, so find an app you want to configure 
and tap it


4. 	The first option is to Allow Notifications from this app. If 
you want notifications, move the slider to On/green, if not 
move it to Off/white and go on to another app


5. 	The next option is to determine if notifications from the app 
will Show in Notification Center (more on what that is at 
the end of this article). Move the slider to On/green, if you 
want that. In earlier versions of the iOS, you could control 
how many notifications from the app would appear in 
Notification Center, but not in iOS 9


6. 	In the Sounds menu, choose whether your iPhone will 
make noise when you have a notification from this app. 
Move the slider to On/green if you want that


7. 	For the built-in apps that come with the iPhone, you can 
also select the ringtone or alert tone that plays when you get 
notifications. Tap the Sounds menu and make your 
selection. Tap the menu in the top right corner to return to 
the previous screen


8. 	The Badge App Icon setting  determines whether a red 
number appears on the app icon when it has notifications 
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for you. This can be helpful to see what needs attention. 
Move the slider to On/green to use it or to Off/white to 
disable it


9. 	The Show in Lock Screen option lets you control whether 
notifications display on your phone's screen even when it's 
locked. You may want this for things that need immediate 
attention, such as voicemail messages and calendar events, 
but may want to disable it for more personal or sensitive 
information


10. 	In the Alert Style When Unlocked box, you control the 
look of notification alerts when your phone is not locked. 
Tap the one you prefer:


	 1.	 None—pretty self-explanatory. You won't see any 
notifications


	 2.	 Banners—short messages at the top of your screen 
that disappear after a few seconds


	 3.	 Alerts—pop up windows in the center of the screen 
that you need to interact with to dismiss.


With those choices made, push notifications are configured for 
that app. Repeat the process for any other app whose notifications 
you want to customize.


C o n t ro l l i n g A M B E R a n d E m e rg e n c y A l e r t 
Notifications 
At the bottom of the Notifications screen, there are two other 
sliders that allow you to control your alert preferences: 


	 •	 AMBER Alerts—These are alerts issued by law 
enforcement during child abductions and related emergencies


	 •	 Emergency Alerts—Alerts related to severe weather 
or other major safety-related events.


How to Turn Off Emergency and AMBER Alerts on iPhone


Using Notification Center 
Notification alerts don't just appear on your home and lock 
screens.


Depending on the settings you choose, they can also appear in 
their own dedicated area of the iPhone: Notification Center.


Learn all about Notification Center.


Notification Center Widgets 
In iOS 8 and above, Notification Center lets you embed mini-apps 
to provide immediate functionality without opening an app, directly 
from the pull-down window.


Learn how to Install & Use Notification Center Widgets. 

 

�35

https://www.lifewire.com/undelete-voicemails-on-iphone-2000558
https://www.lifewire.com/turn-off-emergency-amber-alerts-iphone-1999203
https://www.lifewire.com/notification-center-iphone-1999192
https://www.lifewire.com/how-to-install-and-use-notification-center-widgets-1999212


                 VOLUME 28, NUMBER 5                    MAIN LINE MACINTOSH USERS GROUP                    MAY 2017 

The following article was posted to osxdaily.com on April 17, 2017. 
tinyurl.com/luu6f9g. © OSX Daily. 

How to Save as PDF from iPhone or iPad with a 
Gesture in iOS 10 

It may not be well known, but iOS has 
several ways to save things as PDF and 
print webpages and other documents as 
PDF files. While one of the most popular 
methods involves using 3D Touch, 
another PDF generation approach is 
available to devices without that 
capability, and instead relies on a 
gesture trick to save something as PDF. 
The advantage to saving PDF files with 
the gesture method is that it works on 
iPad as well as iPhone and iPod touch, 
covering a much broader range of 

devices. 


It’s quite simple too, though it is completely hidden from any 
obvious user interaction. We’re going to demonstrate this great 
PDF saving trick by saving a webpage as a PDF on iPhone, iPad, 
and iPod touch, but it works the same with other document types 
from common apps like Notes, Pages, Numbers, and many others. 
You’ll need a modern version of iOS 10 or newer to have this 
special save PDF gesture feature, it is not included in old releases, 
so update your device if need be.


How to Save as PDF on iPad and iPhone with a Zoom 
Gesture in iOS 10 
You can save webpages and most other documents as PDF by 
using a largely hidden and unknown gesture trick at the Print 
screen in iOS, here’s how it works for iPhone and iPad:


	 1.  Open Safari (or an app like Notes) and go to what you 
wish to save as a PDF file, this tutorial uses a webpage for 
example


	 2.  Now tap the Sharing action button, it’s the little square 
with an arrow flying out of the top


3.	 Tap on “Print” from the 
Sha r i ng shee t menu 
options


	 4. At the Print Preview 
screen, place two fingers on 
the preview and spread apart, 
this is basically a reverse 
pinch gesture just like you’d 
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use to zoom into a picture inn iOS


	 5.  This reveals the secret PDF saving option in iOS, now 
again tap on the Sharing action button to save or share the 
webpage or doc as a PDF





You can save the generated PDF to iCloud Drive, or to multiple 
other services and apps, including iBooks, Dropbox, Kindle, and 
more. You can also choose to just share the saved PDF file by way 
of Messages, Mail, or AirDrop too.
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Why such an important and useful feature as saving as PDF is 
hidden behind a gesture on an obscure print screen is a bit of a 
mystery, but perhaps future versions of iOS will make this more 
obvious and easier to access directly in the Sharing menu.


This is not the only way to accomplish PDF generation in iOS, in 
fact you can use the aforementioned print to PDF with iPhone 3D 
Touch trick which is also accessed from the Print screen, or you 
can even save webpages to iBooks app as a PDF file in iOS using 
the simple sharing and save menus, though you will obviously 
need the iBooks app installed on the iPhone or iPad to do that. 


Much older version of iOS are not totally in the dark, you can use 
this older trick to accomplish the same result, it involves 
bookmarking a little javascript snippet and accessing that when 
you want to generate PDF files, not quite as fluid as the native iOS 
approach but it works anyway even on ancient releases of iOS. 


Thanks to Luis for leaving this great alternative PDF saving option 
in our comments! Do you know of any other handy PDF saving, 
generation, or modification tips for iOS? Do you have a favorite 
PDF trick for iPhone or iPad? Let us know in the comments! 
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Elise Moreau posted the following article to lifewire.com on April 
17, 2017. tinyurl.com/lfwa8er. © About.Inc. She is a professional 
blog writer, copywriter and editor for businesses and entrepreneurs 
looking to take their online presence to the next level. 

Best Free Cloud Storage Sites and Their Features 
Store Everything from Photos and Videos, to Word Docs and 
Spreadsheets 
By Elise Moreau 

Maybe you've heard about the cloud, but haven't quite jumped on 
board yet. With so many different options, it's hard to pinpoint 
which is the best free cloud storage site out there. 

Refresher: What is cloud computing, anyway? 


Since each has its own set of advantages, you many want to try 
more than one to see how you like it. Lots of people use multiple 
storage providers for different purposes anyway -- myself 
included. In fact, I use 4 out of 5 on this list! 


Whether you’ve got important documents, photos, music or other 
files that need to be shared across more than one device, using a 
cloud storage option  is often the easiest way to do it. Check out 
the list below for a general summary of each popular cloud service 
and its major features.


01 of 05 Google Drive 
You can't really go wrong 
with Google Drive. In 
terms of storage space 
and file size uploads, it's 
the most generous to its 
free users. Not only can 
you create as many 
folders as you want for all 
your uploads, but you can 
also create, edit, and 
share specific document 

types right in Google Drive.


Create a Google Doc, a Google Sheet, or a Google Slideshow right 
from within your account, and you'll be able to access it from 
anywhere when you sign in to Google Drive. Other Google users 
you share it with will be able to edit or comment on them if you 
give them permission to do so. 

Free storage: 15 GB 
Price for 100 GB: $1.99 per month  
Price for 1 TB: $9.99 per month 
Price for 10 TB: $99.99 per month 
Price for 20 TB: $199.99 per month 
Price for 30 TB: $299.99 per month 
Max file size allowed: 5 TB (as long as it's not converted to Google 
Doc format)  
Desktop apps: Windows, Mac  
Mobile apps: Android, iOS, Windows Phone  

02 of 05 Dropbox 
Because of its simplicity and intuitive design, Dropbox  rivals 
Google as another extremely  popular cloud storage service 
embraced by web users today. Dropbox  allows you to create 
folders to organize all your files, share them with the public via a 
unique link to copy, and invite your friends on Facebook to share 
Dropbox files  too. When you favorite a file (by tapping the star 
button) when viewing it on a mobile device, you'll be able to view it 
again later even if you have no internet connection.  

Even with a free account, you can expand your 2 GB of free 
storage up to 16 GB of free storage by referring new people to join 
Dropbox (500 MB per referral). You can also get 3 GB of free 
storage just for trying out Dropbox's new photo gallery service, 
Carousel.  
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Free storage: 2 GB (With "quest" options to earn more space.)  
Price for 1 TB: $11.99 per month  
Price for unlimited storage (businesses): $17 per month for every 
user 
Max file size allowed: 10 GB if uploaded via Dropbox.com in your 
web browser, unlimited if you upload via the desktop or mobile 
app. Of course, keep in mind that if you're a free user with just 2 
GB of storage, then you can only upload a file as big as what your 
storage quota can take.  
Desktop apps: Windows, Mac, Linux  
Mobile apps: Android, iOS, BlackBerry, Kindle Fire 


03 of 05 Apple iCloud 
If you’ve got any Apple devices working on a recent iOS version, 
you’ve probably already been asked to set up your iCloud 
account. Just like Google Drive integrates with Google tools, 
Apple’s iCloud is also deeply integrated with iOS features and 
functions. iCloud offers a range of incredibly powerful and useful 
features that can be accessed and synced across all your Apple 
machines (and iCloud on the web) including your photo library, 
your contacts, your calendar, your document files, your bookmarks 
and so much more.  

Up to six family members can even share iTunes Store, App Store, 
and iBooks Store purchases  using their own accounts through 
iCloud. You can see the full list of what Apple iCloud offers right 
here.   

You can also opt to get iTunes Match, which lets you store any 
non-iTunes music in iCloud, such as CD music that has been 
ripped. iTunes Match costs an extra $24.99 per year.  

Free storage: 5 GB  
Price for 50 GB: $0.99 per month 

Price for 1 TB: $9.99 per month 

Additional price info:  Pricing varies slightly depending on where 

you are in the world. Check out Apple's iCloud pricing table here.  
Max file size allowed: 15 GB  
Desktop apps: Windows, Mac  
Mobile apps: iOS, Android, Kindle Fire 


04 of 05 Microsoft OneDrive (formerly SkyDrive) 
Just as iCloud is to Apple, OneDrive is to Microsoft. If you use a 
Windows PC, a Windows tablet or a Windows Phone, then 
OneDrive would be the ideal cloud storage alternative. Anyone 
with the latest Windows OS version (8 and 8.1) will come with it 
built right in. 

OneDrive's free storage offering is right up there with Google 
Drive. OneDrive gives you remote file access and allows you to 
create MS Word documents, PowerPoint presentations, Excel 
spreadsheets and OneNote notebooks directly in the cloud. If you 
use Microsoft Office programs often, then this one is a no-brainer.  

You can also publicly share files, enable group editing and enjoy 
automatic photo uploading to your OneDrive whenever you snap a 
new one with your phone. For those that upgrade to get Office 
365, you can collaborate in real time on documents you share with 
other people, with the ability to view their edits directly as they 
happen. 

Free storage: 15 GB  
Price for 100 GB: $1.99 per month  
Price for 200 GB: $3.99 per month  
Price for 1 TB: $6.99 per month (plus you get Office 365) 
Max file size allowed: 10 GB  
Desktop apps: Windows, Mac 

Mobile apps: iOS, Android, Windows Phone 


05 of 05 Box 

Last but not least, there’s Box. Although quite intuitive to use, Box 
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is embraced slightly more by enterprise companies compared to 
individuals who want personal cloud storage options. While larger 
file storage space may cost more compared to other services, Box 
really excels in the area of collaboration for its  content 
management  feature, online workspaces, task management, 
incredible file privacy control, a built-in editing system and so 
much more. 


If you work closely with a team, and need a solid cloud storage 
provider where everyone can work together, Box is hard to beat. 
Other popular enterprise-focused apps like  Salesforce, NetSuite 
and even Microsoft Office can be integrated so you can save and 
edit documents in Box. 

 

Free storage: 10 GB  
Price for 100 GB: $11.50 per month  
Price for 100 GB for business teams: $6 per month for each user  
Price for unlimited storage for business teams: $17 per month for 
each user  
Max file size allowed: 250 MB for free users, 5 GB for Personal Pro 
users with 100 GB of storage  

Desktop apps: Windows, Mac  
Mobile apps: Android, iOS, Windows Phone, BlackBerry  
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Jared Newman posted the following article to techhive.com on 
April 13, 2017.tinyurl.com/m8j797n. © IDG Communications, Inc. 
He is a writer for PCWorld and TechHive 

How To Cut The Cord Without Resorting To A Pricey 
Streaming-TV Bundle 
The case for a purer form of cord cutting—and against channel 
bundles like YouTube TV and Sling TV. 

By Jared Newman 




Confession time: Although it’s my job to review and write about 
streaming channel bundles such as Sling TV, PlayStation Vue, and 
the new YouTube TV, I have little interest in using them personally.


Most of my TV consumption comes from Netflix, Amazon Prime, 
and HBO, all of which are available without a traditional channel 
bundle. As such, I’ve established a viewing pattern that largely 
avoids advertisements, is highly flexible, and is much cheaper than 
cable. Eight years after cutting cable TV, I don’t feel compelled to 
tack on a big bundle of streaming TV channels.


With so many of new bundles emerging—including an upcoming 
Hulu bundle and rumored packages from Comcast and Verizon—
it’s easy to assume you need one to cut the cord. (I’ve even 
defended these bundles as a potential alternative to cable.) But 
there’s also a counterargument: By sacrificing traditional TV 
channels, you may achieve a purer—and arguably, better—form of 
cord cutting.


[ Further reading: The best media streaming devices ]


Same channels, new headaches 
The biggest problem with streaming bundles is the baggage they 
carry, thanks to TV networks desperate to keep old business 
models intact.


Advertisements, for instance, are a big part of traditional TV 
channels, and they’re even harder to avoid with streaming bundles. 
Some channels don’t let you fast forward after pausing live TV, so 
you can’t easily skip commercial breaks, and some on-demand 
programming includes mandatory ad viewing.


While DVR might seem like the answer to these problems, 
streaming bundles tend to load their DVRs with stipulations. 
PlayStation Vue’s DVR service is free, but it only stores 
programming for 28 days. Sling TV’s beta DVR service has no time 
limits, but carries a $5-per-month surcharge. YouTube TV stores 
programs for nine months, but forces users to watch commercials 
for some shows. DirecTV Now doesn’t offer DVR at all. And none 
of these services include convenient ad-skipping features that are 
available on some cable and satellite boxes, such TiVo’s SkipMode 
and Dish’s AutoHop.
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Sling TV’s public DVR beta costs $5-per-month extra. 
Streaming bundles, meanwhile, remain fairly inflexible in terms of 
channel lineups. Networks, for the most part, still insist on selling 
all their channels together, which means entire networks get left 
out of each bundle to keep prices down. YouTube TV, for example, 
doesn’t have Viacom or Turner channels, Sling TV doesn’t have 
channels from Discovery, Sony doesn’t have channels from 
Viacom, and so on. Picking one of these services might save you 
money over cable, but you still might end up with more channels 
than you need, and without some of the ones you want.


Free your mind 
The alternative approach is to avoid traditional TV channels 
entirely. By venturing outside the cable system, you’ll get fewer 
hassles and more flexibility, and you might even find that the 
content is better.


Don’t want to pay for a service that has ads? You’ll find plenty of 
services to meet that need. Some examples:


• SeeSo ($4 per month) for comedy nerds.


• Streaming services galore for film buffs, including FilmStruck 

($7 per month; $11 per month to add the Criterion Channel), 
Mubi ($5 per month), Sundance Now ($7 per month), Tribeca 
Shortlist ($5 per month), and Colony (pay as you go, with 
extras like making-of documentaries, deleted scenes, and 
interviews).


• Acorn TV ($5 per month) and Britbox ($7 per month) for British 
TV.


• Walter Presents ($7 per month) for high-brow foreign-
language dramas.


• Crunchyroll ($7 per month) for anime


• CuriosityStream ($6 per month in HD) and Smithsonian Earth 
($4 per month) for documentary and educational programming


• Boomerang ($5 per month) for classic cartoons


• PBS and PBS Kids, both of which are free with no ads.


If you own a device with Amazon Video, such as a Roku or Fire TV, 
you might also consider Amazon Channels, a selection of a la 
carte channels that includes some of the options above. Amazon’s 
service puts all your subscriptions into a single app, under a single 
billing system, providing some of the same convenience as a 
channel bundle.
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Amazon Channels has been bundling a la carte streaming services. 

The world beyond traditional TV also includes plenty of ad-
supported content for free, which makes a lot more sense than 
paying for a big channel bundle that still includes ads:


• Free movie and TV services such as Crackle, Tubi TV, and 
Shout! Factory TV.


• Streaming news through apps like CBS News, Haystack.tv, 
and NewsOn.


• Vevo or YouTube for music videos.


• The Weather Network for local forecasts and national weather 
trends.


• Interesting entertainment sources like YouTube, Twitch, and 
Redbull TV.


• Pluto TV for a traditional channel-flipping experience.


• A smattering of reality and late-night shows through the free 

sections of TV Everywhere apps.


And don’t forget a la carte TV-show purchases and movie rentals 
from sources like iTunes and Amazon Video. While I wouldn’t 
recommend getting all your content this way, buying a show or two 
could help you avoid cable withdrawal.


Even sports may not be a blind spot in certain situations. Services 
like MLB.TV, NHL.TV, and NBA League Pass provide live streams 
for out-of-market games, and major events may be available 
through an antenna.


Abandoning traditional TV won't work for everyone. It’s a non-
starter for diehard sports fans, and it might be too much trouble for 
people who don’t want to experiment with new sources of content, 
or who just want the convenience of a single TV source.


But if your goal is simply to be entertained and informed, it’s 
increasingly easy to do so without a package of cable channels. 
The reason so many streaming bundles are emerging now is to 
keep people from coming to this realization sooner.


Sign up for Jared’s  Cord Cutter Weekly newsletter  to get this 
column and other cord-cutting news, insights, and deals delivered 
to your inbox.
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 Glenn Kenny posted following article to nytimes.com on March 30, 
2017. tinyurl.com/klhpn7e. © The New York Times Company. He is 
an American film critic and journalist who writes for The New York 
Times. 

Cut The Cord, But Keep The Films? Here Are 3 Ways 
By Glenn Kenny 





Watching television in the long-ago, pre-streaming days. As 
someone old enough to remember the “Stop Pay TV!” campaigns 
that movie theaters and affiliated parties mounted in the late 1960s 
— “Don’t let Pay TV be the monster in your living room,” blared 
one such ad — I am occasionally amused that paying for televised 
entertainment is now pretty much a fact of life. As multidevice 
streaming rapidly evolves into something like the norm, the 
concept of cord-cutting has started becoming a reality for some 
viewers. It’s difficult to find reliable data on how many households 
have given up cable TV and now get all their television via a 
streaming add-on like Roku, Amazon Fire or Google Chromecast. 


I know two couples who have done this. One of them had a 
viewing party on election night last November and hoo, boy, things 
got interesting when a Wi-Fi glitch occurred around 10 p.m. 
Eastern time. (One thing you should make sure you have before 
any kind of cable cord-cutting is reliable high-speed internet, 
without which there’s no streaming.) In any event, it appears that 
the situation for many consumers involves keeping cable and 
shuffling various streaming services.


So in addition to all the other monthly bills, we are also, in this 
scenario, forced to keep up with individual fees for streaming 
services. Bundling is part of why people opt for cable in the first 
place, and it’s becoming a feature of certain streaming services; 
Amazon Video is one of several that lets you piggyback various 
other services, usually at a slightly reduced fee. “Watching TV is 
more complicated than ever,” a pitchman on a broadcast ad for TV 
Guide announced in the 1980s. Wherever that fellow is now, I bet 
he’s terribly confused. 




Vanessa Redgrave in the 1971 film “The Devils.” 

With all this in mind, I’ve assembled three discrete monthly 
streaming “packages” for dedicated movie watchers to consider. 
It’s worth remembering that almost all of the services come with 
one-month free trials. And with some notable exceptions, almost 
all the services offer more than just movies. 
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PACKAGE 1: ‘THE MAINSTREAMER’ Its foundational pillars are 
Amazon Video ($8.99) and Netflix ($9.99). (For the sake of 
coherence, I’m going to stick to monthly rates, before taxes; note 
that Amazon’s video service comes with Amazon Prime’s $99 
annual fee.) Hulu carries more television shows than movies, but 
it’s not light on movies, particularly popular ones. Unless you like 
to watch commercials, in which case your Hulu will run $7.99, the 
desirable option will be commercial-free version at $11.99. Add 
HBO Now ($14.99), Starz ($8.99) and Showtime ($10.99). That’s 
$65.94 worth of monthly streaming. (Explorers of Amazon Video/
Amazon Prime will point out that there’s a good deal of HBO 
programming already free through the service; this doesn’t include 
movies currently on HBO, or the most recent original 
programming, including made-for-the-channel movies. This is 
worth considering when determining whether or not to add HBO 
Now.) But if you want to rent or purchase a film on demand, either 
a classic or something recently released in theaters, there are also 
movies available à la carte, from $2.99 to $14.99, available on 
Amazon, Vudu, Google Play, iTunes and more. Let’s postulate that 
each month you spend $2.99, $4.99 and $14.99 on a single movie 
from one of these — that’s $22.97. So the services and a few 
potentially spur-of-the-moment purchases, you’re looking at 
$88.91. Not exactly cheap, but were I to pitch it to you with the 
proviso “Less Than $100 a Month,” you might think, “Not bad.”  

PACKAGE 2: ‘THE BUFF’ These are movie-only or movie-heavy 
sites that offer cinema of a more artistic, esoteric, possibly 
obscure bent, and reject American cultural hegemony by, in most 
cases, going around the world for their fare. I’d say the foundation 
would be FilmStruck with the Criterion Channel option at $10.99 a 
month. It’s $6.99 a month without Criterion, but you’ll want 
Criterion, for its smartly chosen array of largely foreign cinematic 
milestones. Warner Archive ($9.99) is the odds and ends of a great 
American studio, not a very global concern but still full of enticing 
options. Then there’s the limited-run streaming art house Mubi 
($4.99), which does offer one of the most enticing yearly 

subscription discounts, at $34.99. Fandor, an eclectic and often 
exciting service with thousands of movies ranging from martial arts 
romps such as “Master of the Flying Guillotine” to expansive, 
obscure French brainteasers like “Out 1,” is $10 a month. And the 
solid indie provider Sundance Now, which also offers original 
series, is $6.99. That’s about $43 a month (less than $41 if you 
take the Mubi yearly subscription.)  

PACKAGE 3: ‘THE FRINGE’ If you like genre movies above all, or 
like digging for cinematic thrills in obscure but not necessarily arty 
corners, this might be a good option. You’ll need Warner Archive 
($9.99); the blaxploitation service Brown Sugar ($3.99); and the 
horror specialist Screamhouse ($4.99), which runs scary gamuts 
each with its own menu subheading, including “Extreme,” which 
has the indeed highly unpleasant “Cannibal Ferox.” Shudder, 
another horror service ($4.99), recently made waves by offering the 
controversial Ken Russell nuns-gone-wild film “The Devils”; finicky 
horror lovers almost immediately protested on social media that it 
was not the uncut version. (In fairness to Shudder, the actual 
provenance of an uncut version of this movie is highly obscure.) 
Amazon’s video service is rife with noir titles in various states of 
disrepair or restoration. A lot of genre stuff in the public domain 
(until a copyright owner can effectively yell “Foul!”) is on YouTube, 
which is free; for the sake of argument, we’ll add YouTubeRed 
($9.99) to this bill of fare. Crunchyroll has an anime-only 
membership for $6.95. And the Urban Movie Channel ($4.99) is not 
as blaxploitation-heavy as Brown Sugar, but it doesn’t exactly lack, 
either, especially when it comes to latter-day genre variants like the 
Southern sins-of-the-fathers 2009 thriller “In the Electric Mist” or 
the bayou-psychic tale “The Sickle” (2015). Total: a little over $45; 
with Amazon added as a digging option, a little under $55. 


All this of course can be supplemented by free services other than 
YouTube, like the site of DVD label Shout! Factory and Vimeo. If 
only there was a service that would allow one to buy leisure time, 
we’d be all set.
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AI and Humans 

Translucent 
By Kathy Garges 

Artificial intelligence researchers have been exploring various 
solutions to what has become known as the black box problem in 
deep learning (neural network) AI. The problem is that in many 
cases we don’t know exactly how the AI program reaches its 
conclusions. (See the December 2016 AI and Humans column, 
“What’s Inside the Box?”)

Deep learning, also known as machine learning, mimics the basic 
functions of human learning by trial and error with large amounts 
of data. A parent might say to a child, “See the animal. Is that a 
horse or a goose?” The child says, “A goose.” The parent 
responds, “No, it’s a horse.” After many examples, the child is able 
to put horses and geese in their correct categories. Neurons in the 
child’s brain have learned to distinguish these two animals and 
remember the way to do it.

The “neurons” in machine learning are computer programs, not 
biological structures, but scientists train them in a similar way 
using large amounts of data. There are variations in machine 
learning. The program can be given goal categories for sorting 
data or can be left free to create its own. The training data can be 
systematically labeled in advance, which is time consuming and 
expensive but makes it easier to test accuracy, or the program can 
be set loose on unlabeled data (the entire Internet, for example).

Machine learning has become the dominant focus in AI, with 
recent big leaps in performance in areas like image recognition and 
language translation. The problem comes when we need to find 
the reasons the AI program came to a particular result.

There are many such situations. A regulation adopted by the 
European Union allows it to require a company to explain any 

decision it reached that involved using a computer algorithm. 
Credit card companies would like to use machine learning AI to 
make decisions on granting and denying credit, but U.S. law 
already requires that a reason be given for the denial and machine 
learning AI can’t do that yet. The leader of Apple’s Siri team noted 
that Siri needs to be able to explain a restaurant recommendation. 
We’d expect a human friend who encourages us to try a 
restaurant, or urges us to avoid one, to provide a reason.

If an AI program’s operations are not transparent to human users, 
results can be unreliable and even dangerous. National defense 
systems might not be able to troubleshoot false alarms. Hackers 
might experiment with ways to misuse the program. Using data 
which might already contain bias to train a deep learning program 
that cannot explain its results can create injustice, such as racial 
bias in assessing criminal probation risk – an accusation already 
levelled against an AI program used in criminal justice.

One approach to making deep learning less opaque is to program 
it to identify a pattern it has used to reach its results. Another is to 
reverse engineer the program – trace the program steps 
backwards and dissect its operations – to see what it paid most 
attention to. These approaches can be revealing.

One team found that an AI image recognition program with a high 
accuracy rate was using horse-related words in the image’s 
copyright notice to decide which images contained horses. 
Although this might be acceptable for some applications, it’s not 
what the programmers intended or expected the AI to do. The 
programmers assumed the program was looking at the image itself 
to decide whether it contained a horse. There’s no need to use 
complex machine learning AI to recognize copyright text that has 
the word “horse” in it.

With humans, the reasons someone gives for a decision, or what 
they pay most attention to in making a decision, may not be the 
real reasons they came to that result. A child might be identifying 
horses because they all wear saddles, not because they have four 
legs and a mane. A physician might have an intuition about a 
medical diagnosis based on decades of experience but instead 
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offer to a patient a stereotyped reason that is easier to put into 
words. A teen might spend hours reviewing college information 
about academic offerings but decide where to apply based on the 
schools’ party reputations. Similarly, we cannot be sure these 
ways of testing AI reasoning get to the core of what it is actually 
using to make a choice.

Another way we test human understanding is to have someone 
generate a new example for a category, such as requiring a 
student to use a newly-learned vocabulary word in an original 
sentence. When Google asked its AI image recognition program to 
generate images of a dumbbell, it found that the AI thought a part 
of every dumbbell is a human arm grasping it. The program had 
developed a definition of “dumbbell” which did not include many 
images of dumbbells. Here the biggest dumbbell was the AI 
program, not the exercise equipment.

In areas where decisions are especially important, reducing the 
role of AI to an assistant or adviser to a trained, intelligent human 
may be the best solution. Another option, being pursued by Apple, 
is to spend more resources to generate high quality training data 
for machine learning AI. Apple has reported a new approach that 
modifies images obtained from existing sources (such as Internet 
videos). In this method, data that will be used to train image 
recognition AI is first refined into a “superrealistic” image by an 
adversarial neural network program. The program acts as a devil’s 
advocate by trying to get another neural network to accept fake 
images, with the purpose of modifying images to delete irrelevant 
information.

Implementing solutions like these will reduce some of the 
efficiencies gained by using deep learning AI, but the consensus is 
that these efforts are necessary. Last year, Peter Norvig, Google 
Director of Research, addressed this topic at a conference 
sponsored by MIT Technology Review. He explained the main 
differences between programming for older, logic-based AI and 
new deep learning AI. Logic-based AI included a system of testing 
and updating programs that came from classic, pre-AI computing. 
In contrast, there is no testing of deep learning programs after the 

initial training, and some programs modify themselves on an 
ongoing basis with new data. With a classic computer program, 
there is the capability to isolate and correct bugs with a few lines 
of code, but to correct problems with deep learning AI, 
programmers usually have to retrain the entire program.

Norvig noted that we have less experience with deep learning than 
with logic-based AI. He argued that AI needs a better set of tools, 
and new theories that are better at predicting what humans do. For 
example, we need to ask how humans change their actions based 
on new information so that we can build this function into machine 
learning programs.

It’s uncertain which of these various approaches will prove to be 
the most useful in solving the important problem of making deep 
learning AI operations transparent. Possibly all will be necessary to 
some degree. With the recognition by AI researchers that the black 
box problem is significant, and the development of possible 
solutions, at least deep learning AI is now on the way to becoming 
translucent.

Sources and additional information: 
Will Knight, “The Dark Secret at the Heart of AI,” MIT Technology Review, April 
11, 2017, tinyurl.com/ljezfbd


Tao Lei, Regina Barzilay, Tommi Jaakkola, “Rationalizing Neural Predictions,”  
http://tinyurl.com/j858snc 


Charles McLellan, “Inside the black box: Understanding AI decision, making,” 
ZDNet, December 1, 2016, tinyurl.com/ljbto7g 


Davide Castelvecchi, “Can we open the black box of AI?,” Nature, October 5, 
2016, tinyurl.com/hn3gws4


Jackie Snow, “Brainlike computers are a black box. Scientists are finally peering 
inside,” Science, March 7, 2017, tinyurl.com/n2qo3zf


“Apples first AI paper focuses on creating ‘superrealistic’ image recognition,” 
Kurzweil Accelerating Intelligence News, Dec. 28, 2016, tinyurl.com/hw9rvvk


Peter Norvig, “State-of-the-Art AI: Building Tomorrow’s Intelligent Systems,” MIT 
Technology Review EmTech Digital event, May 23, 2016, tinyurl.com/lt3h9np
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DIRECTIONS 
Take US 202 North or South to PA 29N/Great Valley. Take 
29N and go approximately 0.5 miles and pull into the turn 

lane for Valley Creek Park. You will have passed part of the 
Great Valley Corporate Center on your right.  There is not a 

light at the turn so if you get to the light at Great Valley 
Parkway, you have gone too far. Once you pull into the lot, 

make a short left and right and park. Then walk down the hill 
to the covered pavilion. 

From US 30 (Lancaster Pike), it’s about 1.2 miles on 29N to 
the Park. 

17TH ANNUAL MLMUG  
PICNIC-IN-THE PARK 

Valley Creek Park  
Route 29, East Whiteland. 

Saturday, June 10, 2017 
12 Noon - 4 PM 
(No Raindate) 

All members and their families are welcome. 

Hamburgers, hot dogs, rolls and condiments 
will be provided by MLMUG. All other food and 

beverages will be brought by attendees. 

We’ll need: snacks, salads (green and main 
dish), desserts and beverages (canned sodas, 

juice, iced tea, etc.). 

No alcoholic beverages in the park!  
Pets are OK, but must be leashed and cleaned 

up after. 

It's important that we have accurate 
numbers, so please RSVP: Gail Montgomery 

by Tuesday, June 6 
gailemontgomery@aol.com

PICNIC INFORMATION

mailto:gailemontgomery@aol.com
mailto:gailemontgomery@aol.com

